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About SolarWinds 

SolarWinds, Inc develops and markets an array of network management, monitoring, and discovery 
tools to meet the diverse requirements of today’s network management and consulting professionals. 
SolarWinds products continue to set benchmarks for quality and performance and have positioned 
the company as the leader in network management and discovery technology. The SolarWinds 
customer base includes over 45 percent of the Fortune 500 and customers from over 90 countries. 
Our global business partner distributor network exceeds 100 distributors and resellers. 

Contacting SolarWinds 

You can contact SolarWinds in a number of ways, including the following: 

Team Contact Information 

Sales 
1.866.530.8100 
www.solarwinds.com  

Technical Support www.solarwinds.com/support  

User Forums 
www.thwack.com you need a customer account to access the 
Customer Support area of the website. 

http://www.solarwinds.com/
http://www.solarwinds.com/support
http://www.thwack.com/
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Conventions 

The documentation uses consistent conventions to help you identify items throughout the printed and 
online library. 

Convention Specifying 

Bold Window items, including buttons and fields. 

Italics Book and CD titles, variable names, new terms 

Fixed font 
File and directory names, commands and code examples, 
text typed by you 

Straight brackets, as in 
[value] 

Optional command parameters 

Curly braces, as in 
{value} 

Required command parameters 

Logical OR, as in 
value1|value2 

Exclusive command parameters where only one of the 
options can be specified 
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Chapter 1 

Introduction 

Orion Network Atlas is a powerful tool for creating custom maps and network 
diagrams. The maps created in Orion Network Atlas enable users to view a 
graphical depiction of their network in the Orion Web Console. You can also use 
Orion Network Atlas maps to create your own network documentation, which can 
then be printed and exported as needed. The following sections provide an 
introduction to Orion Network Atlas: 

 What is in a Map? 

 Network Atlas Features 

 Example Maps 

What is in a Map? 

Map objects can be NPM nodes, interfaces, and volumes; SAM applications and 
components; VoIP & Network Quality Manager operations; other Orion Network 
Atlas nested maps; and network links. The numerous presentation options for 
your network maps include: 

 a large set of predefined background colors, textures, and images for use in 
your maps, and the ability to use your own custom background graphics 

 the ability to project real-time weather or natural disaster maps onto your 
network maps using linked web graphics as a background 

 the ability to customize the shape, size, color, and style of map links to 
illustrate the status or the relative bandwidth of associated objects 

 the ability to show map objects in multiple styles to display network status 

 map nesting that selectively reveals increasing levels of map detail with the 
status of child objects on nested maps bubbled up to the parent map 

Network Atlas Features 

Network Atlas gives you the ability to create multi-layered, fully customizable, 
web-based maps of your network to visually track the performance of network 
elements, applications, and operations monitored by any of the following Orion 
applications: 

 Network Performance Monitor 

 Server & Application Monitor 
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 VoIP & Network Quality Manager 

 Enterprise Operations Console 

The following features are currently available in Network Atlas: 

ConnectNow 

The ConnectNow tool in Orion Network Atlas allows you to instantly draw 
lines between mapped objects that are connected on either Layer 2 or Layer 
3. For more information, see “Connecting Objects Automatically with 
ConnectNow” on page 17. 

Utilization and Connection Speed Shown 

Multi-colored links between mapped devices communicate most recently 
determined interface utilization and connection speed. Utilization data is 
available for links that are not automatically created. 

Linked Backgrounds 

The linked backgrounds feature allows you to create maps with backgrounds 
sourced directly from the Internet. Using a linked background, you can create 
maps that include dynamic weather information relevant to your distributed 
network sites. For more information, see “Selecting a Background Image” on 
page 21. 

AutoArrange 

AutoArrange options allow you to quickly structure or reorganize objects on 
your map. For more information, see “Selecting Automatic Layout Styles” on 
page 43. 

Example Maps 

The following figures are examples of the types of maps you can create using 
Orion Network Atlas. 
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Chapter 2 

Installing Orion Network Atlas 

Orion Network Atlas is pre-installed on Orion EOC and Orion NPM, and it can be 
run as a local application on those Orion servers. Users can also run Orion 
Network Atlas as a standalone application on any remote computer meeting the 
stated minimum requirements. The following sections provide more information 
about installing Orion Network Atlas: 

 Orion Network Atlas Requirements 

 Installing Orion Network Atlas on a Remote Computer 

Orion Network Atlas Requirements 

The following table provides the minimum requirements for an Orion Network 
Atlas installation: 

Note: To take full advantage of Orion Network Atlas features, users of Orion 
Network Atlas must either have node management rights in Orion NPM or be 
assigned the administrator role in Orion EOC. Network Atlas may fail to complete 
file synchronization with the Orion database if Network Atlas users do not have 
sufficient permissions to access the Network Atlas synchronization folder. 
Confirm that the user logged in to Network Atlas is able to access the Network 
Atlas synchronization folder. 

Server Component Requirements 

Operating System 
Microsoft Windows XP, Windows Vista, Windows 7, Windows 
Server 2003, or Windows Server 2008 R2. 

Memory 1 GB 

Hard Drive Space 150 MB 

Ports 
Remote instances of Orion Network Atlas require TCP on port 
17777 to either the Orion NPM or the Orion EOC server. 

 

Installing Orion Network Atlas on a Remote Computer 

The following procedure installs Orion Network Atlas on a remote computer. 

To install Orion Network Atlas on a remote computer: 

1. Log on to your Orion NPM or Orion EOC server. 

2. Click Start > All Programs > SolarWinds Orion > Orion Web Console. 
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3. In the Network Map resource, click Download Network Atlas. 

Note: If you do not see a Download Network Atlas link in your Network 
Map resource, click Edit, and then check the Show Network Atlas 
Download link option on the Edit Network Map resource page 
(administrative access may be required). 

4. Save the Network Atlas installer (NetworkAtlas.exe) to an appropriate 

location on your remote computer.  

5. Run the Orion Network Atlas installer on your remote computer. 

6. Click Next on the Welcome window. 

7. If you have previously installed Network Atlas, you may be prompted to 
change, repair or remove your installation. Click Repair, and then click 
Repair again on the Ready to repair window. 

8. If you are installing Network Atlas for the first time, complete the 
following steps: 

a. Accept the terms in the license agreement, and then click Next. 

b. Provide an appropriate installation destination folder, and then click 
Next. 

c. Click Install on the Ready to Install window. 

9. Click Finish when the Setup Wizard completes. 

For more information about starting Network Atlas and creating a new map, see 
“Creating a Basic Map” on page 15. 
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Chapter 3 

Creating a Basic Map 

Creating a map can be as simple as selecting a background image, dragging 
network resources onto the drawing area, and connecting the objects with lines. 

This chapter provides procedures to accomplish the following tasks: 

 Starting Orion Network Atlas 

 Adding Map Objects 

 Connecting Objects Automatically with ConnectNow 

 Connecting Map Objects Manually 

 Using Object Links to Represent Interface Status 

 Interpreting Map Links 

 Using Anchor Points to Reshape Map Links 

 Adding a Background 

 Saving Maps 

 Opening Maps 

 Displaying Maps in the Web Console 

Starting Orion Network Atlas 

The following procedure launches Network Atlas. 

Note: To take full advantage of Network Atlas features, users must have either 
node management rights in Orion NPM or the administrator role in Orion EOC. 

To start Network Atlas: 

1. Log on to the computer hosting your Network Atlas installation. 

2. Click Start > SolarWinds > Network Atlas. 

3. Connect to your primary Orion server, as directed in the following procedure: 

a. Provide your Orion Login and Password. 

Note: Your Orion Login and Password correspond to your Orion Web 
Console User Name and Password. 

b. Provide the IP address or hostname of your primary Orion server in the 
Address field. 
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c. If you are connecting to an Orion NPM server, select Orion as the 
Connect to target. 

d. If you are connecting to an Orion EOC server, select EOC as the 
Connect to target. 

e. Click Connect. 

Adding Map Objects 

Any objects monitored by SolarWinds NPM or SAM may be added to an Orion 
Network Atlas map, including all of the following: 

 NPM nodes, interfaces, volumes, and Universal Device Pollers (UnDPs) 

 SAM applications and components 

 VoIP & Network Quality Manager operations 

 Network Atlas nested maps; and network links. 

For information about populating an Orion database with your network devices, 
see “Discovering and Adding Network Devices” in the SolarWinds Orion 
Common Components Administrator Guide. 

For information about monitoring applications and application components with 
SAM, see the SolarWinds Server & Application Monitor Administrator Guide. 

The following procedure adds monitored network objects to your Orion Network 
Atlas map. 

To add monitored objects to your map: 

1. If you are creating a new map, click the Orion Network Atlas button ( ), 
and then click New Map. 

2. If you are adding objects to an existing map, complete the following 
steps: 

a. Click the Orion Network Atlas button ( ). 

b. Click Open Map. 

c. Navigate to your existing map, and then click Open. 

3. Expand and navigate the node tree in the left pane to locate the network 
nodes and monitored objects you want to add to your map. 

Note: All monitored applications, application components, interfaces, 
volumes, and Universal Device Pollers, associated with monitored nodes, in 
addition to other maps listed in the left pane, are available as map objects. 

file:///C:/DOC/Orion/OrionCoreAdministratorGuide.doc%23DiscoveringAddingNetworkDevices
http://www.solarwinds.com/support/apm/docs/APMAdministratorGuide.pdf
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Click + to expand any listed node and object types and view associated 
interfaces, volumes, applications. 

4. Drag selected objects onto the drawing area. 

Notes: 

 If you want to add all the objects of a selected type on a selected node to 
your map in a single operation, click + next to the node name to reveal all 
its associated monitored network objects, and then drag all objects in the 
desired object group onto the drawing area. 

 A checkmark ( ) next to a node or network resource indicates you have 
already added it to your map. 

 To view details about a map object, hover over it with the mouse pointer. 

 To locate a specific map object in your map, click its network resource in 
the left pane. This selects the map object. 

Connecting Objects Automatically with ConnectNow 

Using the ConnectNow tool, Orion Network Atlas can automatically draw lines 
between directly connected nodes on your network. 

Notes: 

 The ConnectNow tool cannot draw indirect connections between nodes. For 
example, if nodes A and C are connected indirectly through node B, you 
must manually add node B to the map to create the connections. 

 An unidentified node is a node that was found on the network but which is 
not managed by Orion. These devices might be switches, hubs, routers, or 
other devices without names or addresses. They can also be virtual, 
generated to signify an indirect connection within your map in cases when a 
topology calculation cannot find any direct connections between two nodes. 
In these cases, an unidentified node is generated between the two known 
nodes. 

 Because topological data about your network is only generated during 
Network Sonar Discovery, ConnectNow can only draw lines between 
discovered nodes. Nodes that are added manually, as with Node 
Management in the web console, cannot be connected using ConnectNow. 
Orion NPM versions 10.0 and higher allow scheduled network discoveries, 
so you can regularly update topological information about your network. For 
more information about network discovery, see “Discovering and Adding 
Network Devices” in the SolarWinds Orion Common Components 
Administrator Guide. 

 Orion Enterprise Operations Console (EOC) does not support ConnectNow 

file:///C:/DOC/Orion/OrionCoreAdministratorGuide.doc%23DiscoveringAddingNetworkDevices
file:///C:/DOC/Orion/OrionCoreAdministratorGuide.doc%23DiscoveringAddingNetworkDevices
http://www.solarwinds.com/support/Orion/docs/OrionAdministratorGuide.pdf
http://www.solarwinds.com/support/Orion/docs/OrionAdministratorGuide.pdf
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To automatically connect objects using ConnectNow: 

1. Add appropriate nodes to an open network map. 

Note: For more information about adding objects to a network map, see 
“Adding Map Objects” on page 16. 

2. Click Home, and then click ConnectNow ( ). 

Connecting Map Objects Manually 

You can represent network links in your map by drawing lines between map 
objects. If a connected object is down, any connected links change color to red. 

To manually connect map objects: 

1. Click Home. 

2. Click Straight ( ) or Curved Line ( ) in the Lines group, as appropriate. 

3. Click an object with the line drawing tool to begin drawing the link 

4. Click and drag as needed to set optional anchor points along the link path. 

5. Click a second object to finish drawing the link. 

6. If you want the links connecting your mapped objects to communicate 
the status of connected interfaces, complete the following steps: 

a. Right-click a link, and then select Properties. 

b. Select Status in the left pane of the Link Properties page. 

c. Drag the appropriate interface objects from the left pane of the Orion 
Network window to the link status assignment areas. 

Using Object Links to Represent Interface Status  

The following procedure configures an object link to represent the status of its 
connected interfaces. 

To use object links to represent actual interface states: 

1. Right-click a link, and then select Properties. 

2. Select Status in the left pane of the Link Properties page. 

3. Drag the appropriate interface objects from the left pane of the Orion 
Network window to the link status assignment areas. 
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Interpreting Map Links 

Links created on Orion Network Atlas maps are not merely connectors between 
network objects. Map links display the states and performance of the interfaces 
through which your linked objects are connected. Interface states and 
performance data are determined from Orion NPM polling data. 

The following sections describe how interface performance information is 
commuicated in map links: 

 Determining Interface Status 

 Determining Interface Performance 

Determining Interface Status 

Connections are shown as either solid or dotted lines. A solid line indicates that 
the connection is UP. A dotted line indicates that the connection is DOWN. 

The following table relates how interface states are reflected in the status of a 
link between NodeA, with InterfaceA, and NodeB, with InterfaceB. 

Note: Link status is only shown as either UP or DOWN. To emphasize potential 
problem links, DOWN status is granted a higher priority.  

 
InterfaceB Status 

UP DOWN UNKNOWN 

InterfaceA Status 

UP UP DOWN UP 

DOWN DOWN DOWN DOWN 

UNKNOWN UP DOWN DOWN 

 

Determining Interface Performance 

In addition to interface status, map links can show either interface utilization or 
interface connection speed. A legend is available to interpret colors representing 
interface performance data. 

To display interface performance data: 

1. Click View > Show Legend. 

2. In the Connection Display Options window, in the bottom left pane, select 
any of the following options, as appropriate: 
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 Show Link Utilization provides interface utilization information in 
colored links. This option is selected and is shown by default on new 
maps.  

Note: Utilization data is not shown for manually created links. 

 Show Link Speed provides interface connection speed information in 
colored links. 

 Don't show additional info provides only interface UP/DOWN status 
information on device links. This is the default option for previously 
created maps. 

Using Anchor Points to Reshape Map Links 

You can use anchor points to change the shape of object links on your map, as 
shown in the following procedure. 

Note: Use multiple anchor points to create more complex shapes and curves. 

To use object link anchor points: 

1. Click Select  in the Tools group or click the middle mouse button. 

2. Click and drag the link you want to reshape. 

Adding a Background 

You can select colors, textures, and locally-hosted or Internet-hosted images to 
serve as your map backgrounds: 

 Selecting a Background Color 

 Selecting a Background Texture 

 Selecting a Background Image 

 Clearing the Background 

Selecting a Background Color 

Orion Network Atlas supports 24-bit color backgrounds. 

To set a map background color: 

1. Click Home. 

2. Click Background > Background Color ( ). 

3. Select a color from the palette, or click More Colors to select a custom color. 
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Selecting a Background Texture 

Orion Network Atlas also provides numerous colored textures that can serve as 
map backgrounds. 

To set a map background textures: 

1. Click Home. 

2. Click Background > Background Texture ( ). 

3. Enter appropriate values for the Width and Height of your map in the Map 
Size in Pixels area. 

Note: The default values are the smallest area bounding the existing map 
objects and labels. 

4. Select a texture to apply as your map background, and then click OK. 

Selecting a Background Image 

Orion Network Atlas allows you to use images as your map background. The 
source of the background image can be a graphics file on your hard drive or a 
URL link to a graphics file on the Internet in any of the following graphics formats: 

 Graphics Interchange Format (.gif, non-animated) 

 Tagged Image File Format (.tiff) 

 Joint Photographic Experts Group (.jpg) 

 Microsoft Windows Bitmap (.bmp) 

 Portable Network Graphics (.png) 

Linked backgrounds are updated when the map is accessed or when the browser 
page is refreshed. In a typical use case, a linked background is used to provide 
weather data from an Internet weather service on a network map. 

Notes: 

 Files used for linked backgrounds must be continuously accessible by URL 
reference. 

 Files used for static backgrounds must be available within the local file 
system. 

 Background images you supply display at their full size in the Orion Web 
Console, so consider their dimensions. You may rescale images within the 
application, but images displayed at full scale provide optimal quality.  
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 In determining map size and resolution, consider web page layouts and 
potential display screen resolutions. 

 Example background images are in the NetworkAtlas Backgrounds folder 
located in your default shared documents folder. Clicking Background 
Image always starts you in this background images folder. 

To select a background image: 

1. Click Home. 

2. If you want to use a background image from disk, click Background > 

Background Image ( ), and then navigate to the image you want to use. 

3. If you want to use a background image from the Internet, complete the 
following steps: 

Notes: 

 In the web console, map background images linked from the Internet are 
refreshed with the Orion Web Console refresh. 

 If the Orion NPM server is behind a web proxy, the proxy settings 
entered into Microsoft Internet Explorer are used to create the Internet 
connection. If the web proxy requires authentication, you cannot link 
directly to the background image. A workaround is to write a script that 
periodically downloads the Internet image and saves it to a folder on the 
web server. You can then specify the saved image as the linked 
background image. 

a. Click Background > Linked Background ( ). 

b. Type the URL of the image you want to use. 

c. Click Validate. 

d. Click OK. 

Clearing the Background 

To clear the current map background, click Home, and then click Background > 

Clear Background ( ). 
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Saving Maps 

Orion Network Atlas saves your maps directly to the server to which you are 
connected. 

Note: To save a map to your hard drive instead of your Orion server, click  > 
Export > Export Map. 

To save a map: 

1. Click the Orion Network Atlas button ( ), and then click Save. 

2. If you are saving the map for the first time, name the map, and then click 
OK. 

3. If you want to save your map to your hard drive, complete the following 
steps: 

a. Click  > Export > Export Map. 

b. Navigate to an appropriate location on your hard drive. 

c. Provide a File name, and then click Save.  

Opening Maps 

Maps are loaded from the Orion server to which you are connected. They appear 
in the left pane of the Orion Network Atlas window. 

To open a map, 

1. Click + to expand the Maps group in the left pane of the Orion Network Atlas 
window. 

2. Double-click the map you want to open. 

Displaying Maps in the Web Console 

You can display saved maps in the Orion web console Network Map resource. 
The procedure for selecting Network Maps is different between Orion EOC and 
Orion NPM, and maps created for one are not compatible with the other. Select 
either of the following procedures, as appropriate: 

 Map Resources in the Orion NPM Web Console 

 Displaying Maps in the Orion Web Console 

 Displaying Maps in the Orion EOC Web Console 
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Map Resources in the Orion NPM Web Console 

The following map-related resources are available in the Orion NPM Web 
Console: 

Network Map 

The Network Map resource displays a selected map within the Orion Web 
Console. Objectts on the map a user is not permitted to see are hidden from 
the user, as are any connections to those objects. For more information 
about including Network Atlas maps in the Orion Web Console, see 
“Displaying Maps in the Orion Web Console” on page 24. 

All Maps 

This resource provides a list of all available network maps. Clicking any map 
name opens a view containing the selected map with a list of the objects 
included in the map. Clicking an object name or its description opens the 
corresponding Orion NPM device Details page, providing extensive 
diagnostic information about the selected map object. 

Custom List of All Maps 

This resource is a customizable version of the All Maps resource.  

List of Objects on Network Map 

This resource lists all objects displayed on the map shown in the Network 
Map resource. Clicking an object name or its description opens the 
corresponding Orion NPM device Details page, providing extensive 
diagnostic information about the selected map object. 

Displaying Maps in the Orion Web Console 

The following procedure opens a saved map in the Orion Web Console. 

To display a saved map in the Home view of the Orion Web Console: 

1. Log on to the Orion Web Console using an account with administrative 
privileges.. 

2. Click Edit in the Network Map resource. 

3. Select your map from the Select Network Map list. 

4. Click Submit. 
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Displaying Maps in the Orion EOC Web Console 

The following procedure opens a saved map in the Orion EOC Web Console. 

Note: For more information about converting maps to display in an Orion EOC 
Web Console, see "Error! Reference source not found.". 

To display a saved map in the Home view of the Orion EOC web console: 

1. Log on to the Orion EOC web console with an Administrator account. 

2. Click Settings. 

3. Click Manage Views. 

4. Select Home, and then click Edit View. 

5. Click Resource. 

6. Click Network Map in the Added list. 

7. Select your map from the Select Network Map list, and then click Save. 

8. Click OK, Save Changes.  

9. If prompted to confirm your changes, click OK. 

10. Click the Home view to see your map. 
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Chapter 4 

Advanced Mapping Techniques 

You can apply a number of advanced mapping techniques to enhance the 
usefulness of your maps. This section discusses the following topics: 

 Zooming In and Out of a Map 

 Creating Nested Maps 

 Displaying Map Object Metrics 

 Adding Independent Map Objects and Floating Labels 

 Changing the Appearance of Map Objects 

 Changing the Appearance of Links 

 Changing the Appearance of Labels 

 Linking Map Objects to URLs 

 Linking or Embedding Maps in Web Pages 

Zooming In and Out of a Map 

Orion Network Atlas allows you to zoom into a map to enlarge details or to zoom 
out to reduce its size. Zoom level is a visual aid, and it is not saved with the map. 
Use any of the following methods to zoom in or out on a displayed map: 

 Press and hold CTRL while rotating the mouse wheel button. 

 Click the Zoom slider on the status bar, and then slide the zoom control to 
the zoom level you want 

 

 Click View, and then select the type of zoom you want to use from the Zoom 
group. 
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Creating Nested Maps 

Nested maps allow you to navigate through a map to see multiple levels of detail. 
For example, a map of the United States can include an icon for a child map of 
Oklahoma. You can then click the Oklahoma object to open the child map. 

 

The map of Oklahoma can then become a parent map to a network diagram. 

 

Each child map can include a view of the objects, either devices or other maps, 
deployed on it. Any nested objects can then be clicked to view the next level of 
map detail, until the level of the final network device is reached and all available 
network information is displayed. 

Note: The total number of objects on a map, including those displayed on child 
maps, affects how fast the map loads in the Orion Web Console. If your maps 
load slowly, decrease the number of map objects. 

To create a nested map: 

1. Drag a map from the Maps group in the left pane onto the parent map, and 
then position the map icon appropriately. 

2. If you want the status of a child map to also indicate the status of its 
child objects, complete the following steps: 

a. Right-click the child map icon on the map, and then select Properties. 

b. Check Include child status on the Status properties page, and then 
click OK. The object status icon now includes the secondary status 
indicator. 
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Displaying Map Object Metrics 

The status of a map object icon reflects its current state, such as up or down. 
You can add a secondary status indicator to a map object to reflect metrics such 
as response time, CPU load, or the state of any child objects. This secondary 
status indicator appears at the bottom right corner of the status icon. 

To add the secondary status indicator: 

1. Right-click the map object, and then select Properties. 

2. Check Include child status on the Status properties page, and then click 
OK. 

To change the thresholds of the metrics: 

1. Right-click the map object, and then select Properties. 

2. Click Metrics to view the Metrics properties page. 

3. If you want to change the warning or critical threshold for a metric, click 
the threshold value, and then type a new value. 

4. If you want to ignore a metric, uncheck the metric. 

5. Click OK. 

Notes: 

 The secondary status indicator respects the Orion web console Status Rollup 
Mode setting for displaying status. 

 All child objects and selected metric thresholds are taken into account to 
determine secondary status. 

Adding Independent Map Objects and Floating Labels 

You can add independent map objects and labels that do not have associations 
to network nodes or resources.  

To add an independent object: 

1. Click Home. 

2. Click Add Object in the Objects group to add a gray map object to the map. 

Independent labels may also be placed anywhere on your map. 

To add an independent label: 

1. Click Home. 

2. Click Add Label in the Labels group. A label is added to the map. 
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Changing the Appearance of Map Objects 

Changing the graphics that represent map objects is an excellent way of 
increasing the information density of your map without increasing the map 
complexity. 

You can set the default representation style for all map object of a certain type, or 
you can change the appearance of selected map objects. 

To set the default representations of map objects: 

1. Click the Orion Network Atlas button , and then click Network Atlas 
Settings. 

2. Click Graphic Styles in the left column. 

3. Select an appropriate default style for each available map object. 

Changing the representation of selected map objects opens up another level of 
graphical information. For example, you can set an object icon to display a 
mainframe graphic, visually designating the type of device being monitored. You 
can then select a status style, such as 3D Pad Underneath, to illustrate the map 
object status. 

To change the representation of selected map objects: 

1. Right-click a map object, and then select Properties. 

2. Click Appearance in the left column of the Properties page. 

3. If you want the map object to appear as a fixed-size, LED-type graphic, 
complete these steps: 

a. Select Orion LED Status Icon. 

b. Select a style from the Orion LED Status Icon Style list, and then click 
OK. 

4. If you want the map object to appear as a scalable shape, complete 
these steps: 

a. Select Shape 

b. Select a style from the Shape Style list, and then click OK. 

c. Drag a corner handle on the map object to resize the shape.  

5. If you want the map object to appear as a scalable graphic, complete 
these steps. 

a. Select Graphic. 

b. Click Select Graphic, select an appropriate graphic, and then click OK. 
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c. Select a status style from the Graphic Style list, and then click OK. 

d. Drag a corner handle on the map object to resize the graphic. 

Pasting Custom Icons from the Windows Clipboard 

You can paste graphics from the Windows clipboard directly into your Orion 
Network Atlas maps and then display an overlay behind them to depict the 
status. 

Icons that you paste into Orion Network Atlas are saved to the Orion database, 
and made available for reuse in other maps under the "Imported" icon grouping. 
Pasted icons saved to the Orion database can be accessed and used by remote 
instances of Orion Network Atlas. 

To paste a custom icon into Orion Network Atlas: 

1. Open the icon image in a graphics program such as Visio or Photoshop. 

2. Copy the image to the Windows clipboard with the Copy command. 

3. Open the desired map in Orion Network Atlas. 

4. Paste the image as new object following these steps: 

a. Right-click on the map and then click Paste. 

b. Select Paste the image from the Clipboard as a new object. 

c. Enter a name for the this new image in the Please enter a name for the 
new image field. 

d. Click OK. 

Icons added in this manner are also saved on the Orion NPM server in the path 
%APPDATA%\SolarWinds\NetworkAtlas\Maps\Orion\<orion server 

address>\NetObjects\Imported.  %APPDATA% is typically C:\Documents and 

Settings\<logged on user>\Application Data for Windows XP, and 

C:\Users\<logged on user>\AppData\Roaming for Windows Server 2008. 

To delete a custom icon: 

1. Determine which file on the Orion NPM server contains the icon (for 

example, mypicture.wmf). 

2. Add .del to the file name (for example, mypicture.wmf.del) 

3. Start Orion Network Atlas on the Orion NPM server to delete the icons from 
the database. 
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Adding Custom Icons from Graphics Files 

You can use any Windows Media File (.wmf) or Graphics Interchange Format 

(.gif) format graphic as a custom icon, but you must name the graphic files 

according to their roles. The file name must not contain any other dash (-) 
characters other than depicted in this table. 

Role File name 

Critical status iconName-critical.gif 

Down status iconName-down.gif 

External status iconName-external.gif 

Icon with no status iconName.gif 

Unknown status iconName-unknown.gif 

Unmanaged status iconName-unmanaged.gif 

Unplugged status iconName-unplugged.gif 

Unreachable status iconName-unreachable.gif 

Up status iconName-up.gif 

Warning status iconName-warning.gif 

 

To add custom icons from graphics files: 

1. On your Orion NPM server, create the folder: 
%APPDATA%\SolarWinds\NetworkAtlas\Maps\Orion\<orion server addr

ess>\NetObjects\User Graphics. 

Note: %APPDATA% is typically C:\Documents and Settings\<logged on 

user>\Application Data for both Windows XP and Windows Server 2003, 

and C:\Users\<logged on user>\AppData\Roaming for Windows Server 

2008. 

2. Copy the graphics files to this folder. 

3. Start Orion Network Atlas on the Orion server to finalize the additional icons. 

After copying the graphics files to their location, you can assign them as an icon 
as you would any other graphic image. 

To assign a custom icon to an object: 

1. Right-click the object on the map, and then click Select Graphic. 

2. Select User Graphics in the left pane. 

3. Select your desired graphic image, and then click OK. 
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Changing the Appearance of Links 

Orion Network Atlas allows you to change the appearance of network links by 
customizing their width, color, and line styles. 

To change the appearance of a link: 

1. Right-click a link, and then select Properties. 

2. Select Appearance in the left column of the Properties page. 

3. Select a line width in pixels from the Width list. 

4. Select a line color from the Color list. 

5. Select a line style from the Style list. 

6. Click OK. 

Note: The color setting only changes the color of links that have Up status. 

Changing the Appearance of Labels 

Orion Network Atlas allows you to change the appearance of labels by changing 
text attributes, borders, and background colors. 

To move a label: 

Drag the label to the desired location. 

To edit the text in a label: 

Double-click the label. 

Press SHIFT+ENTER to separate multiple lines within the same label. 

To change the appearance of a label: 

1. Right-click the label, and then select Properties. 

2. Select Appearance in the left column of the Properties page. 

3. If you want to change the font attributes, click the … button, select 
appropriate font attributes, then click OK. 

4. If you want to change the text alignment, select an alignment from the 
Text Alignment list. 

5. If you want to change the text color, click the Text Color color box, and 
then select a new color. 

6. If you want to add a label border, select the border width in pixels from the 
Border Width list. 
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7. If you want to change the label border color, click the Border Color color 
box, and then select a new color. 

8. If you want to remove a label border, select 0 from the Border Width list. 

9. If you want to add a label background, uncheck Transparent 
Background. 

10. If you want to change the label background color, click the Background 
Color color box, and then select a new color. 

11. If you want to remove a label background, check Transparent 
Background. 

12. Click OK. 

Linking Map Objects to URLs 

Orion Network Atlas allows users to click on map objects in the Orion web 
console to see more details. By default, map objects are linked to the most 
relevant Orion details page for the object. You can customize the URL hyperlink 
to link to external web sites and pages as necessary. 

To link a map object to a URL. 

1. Right-click the map object, and then select Edit Hyperlink. 

2. If you want to link to the relevant Orion page for the map object, select 
Logical page in Orion. 

3. If you want to link to a custom URL, select Manually set address, and 
then type the URL. 

4. Click OK. 

Linking or Embedding Maps in Web Pages 

You can link or embed your maps in other web pages by referencing the URL for 
the map. The map URL is in the form: 

http://orionServer/Orion/NetPerfMon/MapView.aspx?Map=mapName 

orionServer 

This is the IP address or host name of your Orion NPM server. 

mapName 

This is the display name of the map. If the map display name contains space 

characters, substitute %20 for the spaces when specifying the name. 
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Customizing Orion Web Console Tooltips 

In the web console, hovering over map objects displays a tooltip providing 
current identification and status information about the object. Tooltips are 
customizable for all map object types, and you can customize the tooltips in the 
Orion NPM web console to display additional information by inserting Orion alert 
variables, custom properties, and other text. 

Notes: 

 Tooltip customizations are global and affect all maps. 

 Orion EOC does not support custom web console tooltips. 

 For a complete list of variables available for use in Orion Network Atlas 
tooltips, see “Orion Network Atlas Tooltip Variables” on page 49. 

 Use ${CR} to enter a carriage return.  

To add additional information to map object tool tips: 

1. Log on to Orion NPM as an administrator. 

2. Click Edit in the Network Map resource. 

3. Click Customize map tooltips. 

4. Type the variables and any text you want to add in the text field for the 
appropriate map object type. 

5. Click Submit. 

Example Custom Orion Node Tooltip 

Enter this custom node tooltip definition in the Orion.Nodes field to display node 
location and contact information: 

Orion.Nodes 

Location: ${Location}${CR}Contact: ${Contact} 
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Example Custom Interface Tooltip 

Enter this custom interface tooltip definition in the Orion.NPM.Interfaces field to 
display the current bandwidth usage: 

Orion.NPM.Interfaces 

Downlink:${Inbps}${CR}Uplink:${Outbps} 

 

Tooltip variables are available for NPM, SAM, EOC, and VoIP & Network Quality 
Manager. For more information about available tooltip variables, see “Orion 
Network Atlas Tooltip Variables” on page 49. For more information about custom 
properties, see “Creating Custom Properties” in the SolarWinds Orion Common 
Components Administrator Guide. 

Importing Orion NPM Maps into Orion EOC 

Maps created for use in Orion NPM must be converted before they may be used 
in Orion EOC. SolarWinds provides a utility for this conversion, as indicated in 
the following sections. 

Map Import Requirements and Configuration 

The Orion to EOC Map Converter utility imports maps into Orion EOC v1.5 from 
other SolarWinds Orion products. Before attempting to convert maps for use in 
Orion EOC, confirm that your environment meets the following requirements: 

 Orion EOC must currently be managing at least one SolarWinds Orion 
server. 

 If Orion EOC is configured to use Active Directory accounts to access Orion 
servers, confirm that you have entered the password for the AD account in 
the Orion Logins section of EOC. Additionally, only AD accounts that were 
individually added to the Orion Server may be used to import a map. Active 
Directory group accounts are not compatible with Map Converter. 

file:///C:/DOC/Orion/OrionCoreAdministratorGuide.doc%23CreatingCustomProperties
http://downloads.solarwinds.com/solarwinds/Release/Components/SolarWinds-OrionToEOCMapConverter-v1.5.zip


 

 
Advanced Mapping Techniques  37 

 The user running the Orion to EOC Map Converter utility must also meet the 
following specifications: 

o The user must run the Map Converter using a Windows Administrator 
account that also has Orion EOC Administrator role permissions. 

o The user must log into the Map Converter using an Orion EOC account 
that was individually added to Orion EOC. Active Directory group 
accounts are not compatible with Map Converter. 

o The user must have Orion EOC access to at least one Orion server. 

o The user must have Node Management rights on the remote Orion 
server 

To configure your environment for map import: 

1. Copy SolarWinds-OrionToEOCMapConverter-1.5.exe to your Orion 

EOC server. 
Note: Download SolarWinds-OrionToEOCMapConverter-1.5.exe from 

http://downloads.solarwinds.com/. 

2. Execute SolarWinds-OrionToEOCMapConverter-1.5.exe, and then 

complete the installer. 

3. Allow members of the Users group Full Control of files in the folder 
<volume>:\Windows\Microsoft.NET\Framework\v2.0.50727\Tempor

ary ASP.NET Files, as follows: 

a. Using Windows Explorer, find the folder 
<volume>:\Windows\Microsoft.NET\Framework\v2.0.50727\

Temporary ASP.NET Files. 

b. Right-click the folder, and then click Properties. 

c. Open the Security tab. 

d. If you are using Windows 2008, click Edit. 

e. Select Users in the Group or User Names list, select Full 
Control, and then click OK. 

4. Allow the Everyone group Full Control to the folder 
<volume>:\Windows\Temp\SolarWinds\NetworkAtlas\EOC\SolarWin

ds\NetworkAtlas\MapsWeb\EOC\localhost and all of its child objects, 

as follows: 

a. Using Windows Explorer, find the folder 
<volume>:\Windows\Temp\SolarWinds\NetworkAtlas\EOC\So

larWinds\NetworkAtlas\MapsWeb\EOC\localhost. 

b. Right-click the folder, and then click Properties. 

http://downloads.solarwinds.com/solarwinds/Release/Components/SolarWinds-OrionToEOCMapConverter-v1.5.zip


Administrator Guide  SolarWinds Orion Network Atlas 
 

 
38  Advanced Mapping Techniques 

c. Open the Security tab. 

d. If you are using Windows 2008, click Edit. 

e. Click Add. 

f. Enter Everyone in the Enter the object names to select text 
box, and then click OK. 

g. Click Advanced. 

5. Select Replace permission entries on all child objects with entries 
shown here that apply to child objects, and then click OK. 

6. Click Yes when prompted to continue. 

7. Select Everyone in the Group or User Names list. 

8. Select Full Control, and then click OK. 

Importing Maps into Orion EOC 

The following procedure imports maps into your Orion EOC environment. 

To import maps into Orion EOC: 

1. Log on to the Orion EOC server with a Windows Administrator account 
that also has Orion EOC Administrator role permissions. 

2. If you are using Windows Server 2008, right-click Start > All 
Programs > SolarWinds > Convert Orion maps to EOC, and then 
click Run as Administrator. 

3. If using Windows Server 2003, click Start > All Programs > 
SolarWinds > Convert Orion maps to EOC. 

4. Select the Orion server hosting your maps from the Orion list. 

5. Select the maps you want to import into Orion EOC. 

6. If you want to edit the name of an Orion EOC map you are 
importing, click the map name in the New Name column and then edit 
the name. 

7. Click Import. 
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Troubleshooting 

The following issues may arise as you import Orion maps into Orion EOC: 

 Maps you import from different Orion servers may share the same name. 
You must rename these maps so that each has a unique name in Orion 
EOC. Any pre-existing child/parent relationships for any renamed map 
will break. You must manually reconfigure parent/child relationships after 
importing. 

 Windows 2008 customers may encounter problems either after manually 
clicking the Refresh button or after selecting a different Orion server. If 
the utility crashes, restart it and resume importing. 

 If using an operating system such as Windows Server 2008 that has 
UAC, you must run the program using Run as Administrator. 
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Chapter 5 

Advanced Map Layouts 

You can improve the visual layout and organization of your maps by using the 
advanced layout tools to help you align and distribute your objects and links. This 
section discusses the following topics: 

 Positioning Map Objects 

 Displaying Grid Guides 

 Aligning Map Objects 

 Distributing Map Objects 

 Selecting Automatic Layout Styles 

Positioning Map Objects 

Using drag-and-drop from the objects tree on the left, you can place and move 
map objects anywhere on your map. More precise movement and positioning are 
also possible, using the nudge and position features. 

To nudge a map object, select the object, and then press Ctrl+arrow. 

To reposition a map object: 

1. Click the map object to reposition. 

2. Click Edit. 

3. In the Size & Position area, enter appropriate X and Y coordinates. 

Note: Map center is designated as (X,Y) = (0,0). 

Displaying Grid Guides 

A grid guide helps you maintain structural and spatial relationships as you 
arrange your map objects. Orion Network Atlas allows you to select two kinds of 
grids and to change the grid spacing. Grids are not map objects, and are neither 
saved with a map nor displayed in the Orion Web Console. 

To display a grid: 

1. Click View. 

2. Click Show Grid  in the Grid group. 
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To customize the grid: 

1. Click View. 

2. If you want grid lines, click Grid Option > Grid Lines. 

3. If you want grid points, click Grid Options >Grid Points. 

4. If you want to change the grid size, click Grid Options > Grid Size, and 
then select a grid size. 

Aligning Map Objects 

You can change the relative alignment of  your map objects using the alignment 
tools.  

1. Click Edit. 

2. Select the map objects you want to align. 

3. Click the appropriate button in the Align group to arrange your selected 
objects 

Button Function Description 

 
Align Left 

Aligns all selected objects on the left edge of the 
group 

 
Align Right 

Aligns all selected objects on the right edge of the 
group 

 Align Bottom 
Aligns all selected objects on the bottom edge of the 
group 

 Align Top 
Aligns all selected objects on the top edge of the 
group 

 

Center 
Vertically 

Centers all selected objects vertically 

 
Center 
Horizontally 

Centers all selected objects horizontally 
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Distributing Map Objects 

You can distribute your map objects evenly across the selection area using the 
distribution tools. 

1. Click Edit. 

2. Select the map objects you want to distribute. 

3. Click the appropriate button in the Distribute group to arrange your selected 
objects 

Button Function Description 

 
Distribute 
Horizontally 

Distributes all objects so that they are equidistant 
from the left edge of the leftmost object to the right 
edge of the rightmost object 

 
Distribute 
Vertically 

Distributes all objects so that they are equidistant 
from the top edge of the topmost object to the bottom 
edge of the bottommost object 

 

Selecting Automatic Layout Styles 

You can select from the following five styles to automatically change the relative 
positioning of objects your map:  

Circular  

Emphasizes the clusters inherent in the topology of a map. It emphasizes 
prominent links between main objects and its peripherals. Object groups 
have radial placements. Use circular layouts for maps containing ring and 
star network topologies. 

Symmetrical  

Emphasizes the symmetrical patterns inherent in the map topology. It 
emphasizes an even distribution of objects, and minimizes edge crossings. 
Object groups have star spiral placements. Use symmetrical layouts for 
maps that have fairly homogenous or uniform clusters. 

Hierarchical  

Emphasizes mapped dependency relationships by placing objects at different 
levels. Use hierarchical layouts to depict data dependencies. 

Orthogonal  

Emphasizes compact drawings and uses only horizontal and vertical edges. 
Objects are enlarged if necessary to provide enough space for edge 
connections. Use orthogonal layouts for maps that need to depict multiple 
clusters in a space-efficient manner. 
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Tree  

Emphasizes parent and child relationships. Child objects are arranged farther 
from the root object than their parent objects. Use tree layouts for maps that 
have a central control object. 

Reorganize  

Moves all mapped objects back to the center of the map view. 

Arrange Labels  

Restores the default relative position of all object labels. 

To arrange map objects according to a layout style: 

1. Click Edit. 

2. Click an apprpriate layout style from the AutoArrange group. 
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Chapter 6 

Map Properties 

The Map Properties window allows you to configure options regarding the 
following aspects of your map: 

 Setting the Map Up Status Threshold 

 Overriding Account Limitations 

Setting the Map Up Status Threshold 

The UP status threshold is the percentage of map objects that must be in an up 
state on a given map for the map to be represented as up on the parent map. 

To set the percentage of map objects that determine Up status of a map: 

1. Right-click any empty portion of the map, and then select Map Properties. 

2. Slide the Map status will be UP slider to configure an appropriate up state 
threshold on the Map Properties page. 

Overriding Account Limitations 

For security reasons, you may wish to prevent web console users who have 
account limitations from seeing network nodes on the map they are not allowed 
to see. By hiding the restricted nodes and links, users with account limitations 
remain unaware that the nodes even exist.  

To hide nodes from users who have account limitations: 

1. Right-click any empty portion of the map, and then select Map Properties. 

2. Select Remove nodes that users do not have permission to view. 

If you choose to reveal restricted nodes to all users, all web console users can 
see the restricted nodes, but users with account limitations cannot retrieve any 
additional information about the restricted node.  

To reveal nodes to all users: 

1. Right-click any empty portion of the map, and then select Map Properties. 

2. Select Allow all users to view all nodes on this map. 

Note: An Orion NPM user with account limitations, but who has permission to run 
and use the Orion Network Atlas application, can change this setting in the map 
and see the presence of restricted nodes. Although the user cannot retrieve any 
information regarding the restricted nodes, this can still be considered a security 
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risk. If this is a concern, do not give node management permissions to Orion 
NPM users who have account limitations. 
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Chapter 7 

Orion Network Atlas Settings 

You can customize the default icon styles, map defaults, and node tree 
specifications from the Orion Network Atlas Settings window. 

To open the Orion Network Atlas Settings window, click the Orion Network Atlas 

button ( ), and then click Network Atlas Settings. 

The following sections describe the options available in the Orion Network Atlas 
Settings window. 

Connection Settings 

The options in this section allow you to select the default Orion server details. 

Map Defaults 

The options in this section allow you to set a device threshold for the overall 
map status. The status indicator reflects the state of many objects at once; 
therefore, SolarWinds recommends that the map status be set at 100%. At 
this setting, when any device on a map or sub-map is down, the problem 
status will be indicated. 

Node Tree 

The options in this section allow you to customize the view of the node tree 
located on the left pane of the Orion Network Atlas main window. Some 
users find it helpful to display the status icons of each node and interface, 
while others find the vendor network node and interface icons more useful. 
You may also specify that node names and/or IP addresses be included in 
the display. 

Graphic Styles 

The options in this section  allow you to select the default graphical styles for 
Orion Network Atlas. You can change the default style types for network 
objects, and you can select a color scheme for Orion Network Atlas itself. 
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Appendix A 

Orion Network Atlas Tooltip Variables 

Many of the variables that are available for use in Orion NPM alerts are also 
available for use in Network Atlas tooltips. These variables are dynamic, and they 

parse when the tooltip is opened. For example, the variable ${CPULoad} will 

parse with the current processor utilization of the node you are viewing. The 
following sections provide tables of variables corresponding to the types of 
objects you can map with Network Atlas. 

Notes: 

 For more information about viewing and customizing Network Atlas tooltips, 
see “Customizing Orion Web Console Tooltips” on page 35. 

 In some cases, the table name may be required for alert variables, as in 

${Nodes.Description}. The following tables provide the table name in 

listed variables when it is required. 

 In earlier versions of Network Atlas, variables were referred to as macros. 

Application Variables 

The following application variables are valid for use in Network Atlas tooltips. 

Variable Description 

${ApplicationID} Internal unique identifier of the application 

${ApplicationTemplateID } Internal unique identifier of the parent template 

${Name} Application name 

${NodeID} Internal unique identifier of assigned node 

${Status} 
Numerical application status code. For more information see 
“Status Icons and Identifiers” in the SolarWinds Orion 
Network Performance Monitor Administrator Guide. 

${StatusDescription} User friendly application status 

${UnManaged} States if application is currently unmanaged 

 

file:///C:/DOC/Orion/OrionNPMAdministratorGuide.doc%23StatusIconsIdentifiers
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Application Component Monitor Variables 

 The following application component monitor variables are valid for use in 
Network Atlas tooltips. 

Variable Description 

${ApplicationId} Internal unique identifier of the associated application 

${ComponentId} Internal unique identifier of the component 

${ComponentType} 
Numerical component monitor type code. For more information, 
see “Orion SAM Alerts” in the SolarWinds Server & Application 
Monitor Administrator Guide.  

${Name} Component monitor name 

${Status} 
Numerical application status code. For more information see 
“Status Icons and Identifiers” in the SolarWinds Orion Network 
Performance Monitor Administrator Guide. 

${StatusDescription} User friendly application status 

${TemplateID} Internal unique identifier of the parent template 

Date and Time Variables 

The following date and time variables are valid for Network Atlas tooltips. 

Variable Description 

${AbreviatedDOW} Abbreviated current day of the week. 

${AMPM} AM/PM indicator 

${D} Current day of the month 

${Date} Current date. (Short Date format) 

${DateTime} 
Current date and time. (Windows control panel defined “Short 
Date” and “Short Time” format) 

${DayOfWeek} Current day of the week. 

${ DayOfYear} Numeric day of the year 

${DD} Current day of the month (two digit number, zero padded) 

${H} Current hour 

${HH} Current hour. Two digit format, zero padded. 

${Last24Hours} Time period: the last 24 hours 

${Last2Hours} Time period: the last 2 hours 

${Last7Days} Time period: the last 7 days 

${LastHour} Time period: the last hour 

http://www.solarwinds.com/NetPerfMon/SolarWinds/default.htm?href=OrionAPMAGOrionAPMAlerts.htm
http://www.solarwinds.com/support/apm/docs/APMAdministratorGuide.pdf
http://www.solarwinds.com/support/apm/docs/APMAdministratorGuide.pdf
file:///C:/DOC/Orion/OrionNPMAdministratorGuide.doc%23StatusIconsIdentifiers
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Variable Description 

${LocalDOW} Current day of the week. Localized language format. 

${LocalMonthName} Current month name in the local language. 

${LongDate} Current date. (Long Date format) 

${M} Current numeric month 

${MediumDate} Current date. (Medium Date format) 

${Minute} Current minute. Two digit format, zero padded. 

${MM} Current month. Two digit number, zero padded. 

${MMM} Current month. Three character abbreviation. 

${MMMM} Full name of the current month 

${S} Current second. 

${Second} Current second. Two digit format, zero padded. 

${Time} Current Time. (Short Time format) 

${Today} Time period: today 

${Year} Four digit year 

${Year2} Two digit year 

${Yesterday} Time period: yesterday 

General Variables 

The following general variables are valid for use in Network Atlas tooltips. 

Variable Description 

${Acknowledged} Acknowledged status 

${AcknowledgedBy} Who the alert was acknowledged by 

${AcknowledgedTime} Time the alert was acknowledged 

${AlertTriggerCount} Count of triggers 

${AlertTriggerTime} 
Date and time of the last event for this Alert. (Windows control 
panel defined “Short Date” and “Short Time”) 

${Application} SolarWinds application information 

${Copyright} Copyright information 

${CR} Line Feed – Carriage Return 

${ObjectName} Description/Name of the object in the alert 

${Release} Release information 

${Version} Version of the SolarWinds software package 
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Group Variables 

The following group variables are valid for use in Network Atlas tooltips. 

Variable Description 

${ContainerID} Designated identifier for a mapped group 

${DetailsURL} URL of the Group Details view for a mapped group 

${Frequency} 
Interval on which group membership is evaluated and group 
snapshots are taken. 

${IsDeleted} 

When a group is marked for deletion, it is not deleted 
immediately. If a group is marked for deletion but not yet deleted, 

${IsDeleted} returns 1.   

${LastChanged} 
The date and time of the last change made to the definition of a 
group. This does not include changes made to group members 
resulting from dynamic queries. 

${Name} The name assigned to the mapped group 

${Owner} Orion product appropriate to the mapped group type 

${RollupType} 

Name of roll-up logic calculator that evaluates status of the 

mapped group based on member statuses. 0 = Mixed, 1 = 

Worst, 2 = Best. The “Worst” method reports group status as the 

worst status of any of its members. The “Mixed” method reports 
group status as ”Warning” when members are of multiple 
different statuses. The “Best” method reports group status as the 
best status of any of its members. 

${Status} 
Status of the mapped group. For more information, see 
“Managing the Display of Group Status” in the SolarWinds Orion 
Common Components Administrator Guide. 

${StatusCalculator} 

Name of roll-up logic calculator that evaluates status of the 

mapped group based on member statuses. 0 = Mixed, 1 = 

Worst, 2 = Best. The “Worst” method reports group status as the 

worst status of any of its members. The “Mixed” method reports 
group status as ”Warning” when members are of multiple 
different statuses. The “Best” method reports group status as the 
best status of any of its members. 

${Uri} 
Uri used by SolarWinds Information Service (SWIS) to refer to 
the selected group member within the web console. 

${WebUri} URL of the Group Details view for a mapped group 

 



 

 
Orion Network Atlas Tooltip Variables  53 

Interface Variables 

The following interface variables are valid for use in Network Atlas tooltips. 

Variable Description 

${AdminStatus} 

Numeric administrative status of interface. For more 
information see “Status Icons and Identifiers” in the 
SolarWinds Orion Network Performance Monitor 
Administrator Guide.  

${AdminStatusLED} Filename of current interface administrative status icon 

${Caption} 
User friendly description of interface combining name 
with other identifying information 

${Counter64} 
States if interface supports IF-MIB high capacity 
counters 

${CustomBandwidth} 
Indicates if transmit and receive bandwidth fields are 
user-controlled (1) or controlled by automated 
detection via ifSpeed MIB (0) 

${CustomPollerLastStatisticsPoll} 
Day, date, and time that this interface was last polled 
by the current poller 

${InBandwidth} Incoming bandwidth of interface 

${Inbps} Current incoming traffic, in bps, to interface 

${InDiscardsThisHour} 
Number of incoming packets discarded by interface in 
last hour 

${InDiscardsToday} 
Number of incoming packets discarded by interface in 
current day 

${InErrorsThisHour} Number of interface receive errors in last hour 

${InErrorsToday} Number of interface receive errors in current day 

${InMcastPps} 
Current incoming multicast traffic, in packets per 
second, to interface 

${InPercentUtil} Current percent utilization of interface receive 

${InPktSize} Average size of incoming packets to interface 

${InPps} 
Current incoming traffic, in packets per second, to 
interface 

${InterfaceIcon} Filename of the icon represent the interface type 

${InterfaceID} Internal unique identifier of selected interface 

${InterfaceIndex} Index of selected interface on parent node 

${InterfaceLastChange} 
sysUpTime value when the interface entered current 
operational state 

${InterfaceMTU} 
Interface Maximum Transfer Unit: the largest packet 
the interface can handle 

${InterfaceName} User friendly name 
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Variable Description 

${InterfaceSpeed} Interface bandwidth 

${InterfaceType} IANA type of selected interface 

${InterfaceTypeDescription} User friendly description of interface type 

${InterfaceTypeName} User friendly name of interface IANA type 

${InUcastPps} 
Current incoming unicast traffic, in packets per second, 
to interface 

${LastSync} 
Time and date of last interface database and memory 
synchronization 

${MaxInBpsTime} Time when ${MaxInBpsToday} was measured 

${MaxInBpsToday} Maximum measured traffic, in bps, into interface 

${MaxOutBpsTime} Time when ${MaxOutBpsToday} was measured 

${MaxOutBpsToday} Maximum measured traffic, in bps, out from interface 

${NextPoll} Day, date and time of next scheduled interface polling 

${NextRediscovery} Next interface rediscovery time 

${NodeID} 
Internal unique identifier of node that is parent to the 
selected interface 

${ObjectSubType} States if parent node supports SNMP or is ICMP only 

${OperStatus} 

Numeric operational status of interface. For more 
information see “Status Icons and Identifiers” in the 
SolarWinds Orion Network Performance Monitor 
Administrator Guide. 

${OperStatusLED} Filename of current interface operational status icon 

${OutBandwidth} Outgoing bandwidth of interface 

${Outbps} Current outgoing traffic, in bps, from interface 

${OutDiscardsThisHour} 
Number of outgoing packets discarded by interface in 
last hour 

${OutDiscardsToday} 
Number of outgoing packets discarded by inteNumber 
of interface transmit errors in last hourrface in current 
day 

${OutErrorsThisHour} Number of interface transmit errors in last hour 

${OutErrorsToday} Number of interface transmit errors in current day 

${OutMcastPps} 
Current outgoing multicast traffic, in packets per 
second, from interface 

${OutPercentUtil} Current percent utilization of interface transmit 

${OutPktSize} Average size of outgoing packets from interface 

${OutPps} Current outgoing traffic, from interface, in pps 
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Variable Description 

${OutUcastPps} 
Current outgoing unicast traffic, in packets per second, 
from interface 

${PhysicalAddress} Physical address of interface 

${PollInterval} 
Interval, in seconds, between polling attempts for 
interface 

${RediscoveryInterval} 
Interval, in minutes, between rediscovery attempts for 
interface 

${Severity} 
A network health score providing 1 point for an 
interface in a warning state, 1000 points for a down 
interface, and 1 million points for a down node 

${StatCollection} Interface statistics collection frequency, in minutes 

${Status} 
Numeric interface status. For more information see 
“Status Icons and Identifiers” in the SolarWinds Orion 
Network Performance Monitor Administrator Guide. 

${StatusLED} Filename of current interface status icon 

${UnManaged} States if interfacee is currently unmanaged 

${UnPluggable} States if interface is designated as unpluggable 

IP SLA Variables 

The following variables related to IP SLA operations are valid for use in Network 
Atlas tooltips. 

Variable Description 

${DateChangedUtc} The last time operation information was updated 

${Description} A user defined explanation of the operation 

${Frequency} How often the operation is performed 

${IpSlaOperationNumber} The time between operation executions 

${IsAutoConfigured} 
This value is True if it was created by VoIP & Network 

Quality Manager, False if it was created by the user 

${OperationInstanceID} The internal ID of the operation. 

${OperationName} The name of the operation as it appears in Orion 

${OperationTypeID} 

Numerical operation status code. 1=DHCP, 2=DNS, 3=FTP, 

4=HTTP, 5=ICMP Echo, 8=TCP Connect, 9=UDP Echo, 

10=UDP Jitter, 11=VoIP UDP Jitter 

${SourceNodeID} The Orion node ID of the source node 

${Status} 
Numerical operation status code. For more information see 
“Status Icons and Identifiers” in the SolarWinds Orion 
Network Performance Monitor Administrator Guide. 
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Variable Description 

${StatusMessage} A message that describing the ${Status} value. 

${TargetNodeID} The Orion node ID of the node the operation is targeting 

Node Variables 

The following node variables are valid for use in Network Atlas tooltips. 

Variable Description 

${AgentPort} Node SNMP port number 

${Allow64BitCounters} Node allows 64-bit counters (1), or not (0) 

${AvgResponseTime} 
Average node response time , in msec, to 
ICMP requests 

${BlockUntil} 
Day, date, and time until which node polling is 
blocked 

${Caption} User friendly node name 

${Community} Node community string 

${CPULoad} Node CPU utilization rate at last poll 

${CustomPollerLastStatisticsPoll} 
Day, date, and time of last poll attempt on 
node 

${CustomPollerLastStatisticsPollSuccess} 
Day, date, and time that node was last 
successfully polled 

${DateTime} 
Current date and time. (Windows control 
panel defined “Long Date” and “Long Time” 
format) 

${Description} Node hardware and software 

${DNS} Fully qualified node name 

${DynamicIP} 
If node supports dynamic IP address 
assignment via BOOTP or DHCP (1); static IP 
address return (0) 

${EngineID} 
Internal unique identifier of the polling engine 
to which node is assigned 

${External} 
States if node is currently designated as 
external 

${GroupStatus} 
Filename of status icon for node and its 
interfaces 

${IOSImage} Family name of Cisco IOS on node  

${IOSVersion} Cisco IOS version on node 

${IP_Address} Node IP address 
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Variable Description 

${LastBoot} Day, date and time of last node boot 

${LastSync} 
Time and date of last node database and 
memory synchronization 

${MachineType} 
Node manufacturer or distributor and family or 
version information 

${MaxResponseTime} 
Maximum node response time , in msec, to 
ICMP requests 

${MemoryUsed} Total node memory used over polling interval 

${MinResponseTime} 
Minimum node response time , in msec, to 
ICMP requests 

${NextPoll} 
Day, date and time of next scheduled node 
polling 

${NextRediscovery} Time of next node rediscovery 

${NodeID} Internal unique identifier of node 

${NodeName} 

Node hostname. Defaults to node IP address 

${IP_Address} if hostname does not 

resolve.  

${ObjectSubType} 
States if node supports SNMP or is 
ICMP-only 

${PercentLoss} 
ICMP packet loss percentage when node last 
polled 

${PercentMemoryUsed} 
Percentage of total node memory used over 
polling interval 

${PollInterval} Node polling interval, in seconds 

${RediscoveryInterval} Node rediscovery interval, in minutes 

${ResponseTime} 
Node response time, in milliseconds, to last 
ICMP request 

${RWCommunity} 
Node read/write community string; acts as 
security code for read/write SNMP access 

${Severity} 

A network health score providing 1 point for 
an interface in a warning state, 1000 points 
for a down interface, and 1 million points for a 
down node. 

${SNMPVersion} States the version of SNMP used by the node 

${StatCollection} Statistics collection frequency, in minutes 

${Status} 

Numerical node status. For more information 
see “Status Icons and Identifiers” in the 
SolarWinds Orion Network Performance 
Monitor Administrator Guide. 

${StatusDescription} User friendly node status 
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Variable Description 

${StatusLED} Filename of node status icon 

${SysName} 
String reply to SNMP SYS_NAME OID 
request 

${SysObjectID} 
Vendor ID of the network management 
subsystem in OID form. Clearly determines 
the type of node. 

${SystemUpTime} 
Time, in hundredths of a second, since 
monitoring started 

${TotalMemory} Total node memory available 

${UnManaged} States if node is currently unmanaged 

${UnManageFrom} 
Day, date, and time when node is set to 
“Unmanaged” 

${UnManageUntil} 
Day, date, and time when node is scheduled 
to be managed 

${Vendor} Node manufacturer or distributor 

${VendorIcon} Filename of node vendor logo icon 

Volume Variables 

The following volume variables are valid for use in Network Atlas tooltips. 

Variable Description 

${Caption} User friendly volume name 

${FullName} 
User friendly volume name including captions of 
parent node and interface 

${LastSync} 
Time and date volume last synchronized in 
database and memory models 

${NodeID} Internal unique identifier of parent node 

${Status} 
Numerical volume status: (0=”Unknown”, 1=”Up”, 
2=”Shutdown”, 3=”Testing”) 

${StatusLED} Filename of volume status icon 

${VolumeAllocationFailuresThisHour} 
Number of volume allocation errors for this 
volume in last hour 

${VolumeAllocationFailuresToday} 
Number of volume allocation errors for this 
volume in current day 

${VolumeDescription} User friendly volume description 

${VolumeID} Internal unique identifier of volume 

${VolumeIndex} Unique index of volume within the parent node 



 

 
Orion Network Atlas Tooltip Variables  59 

Variable Description 

${VolumePercentUsed} Percentage of volume currently in use 

${VolumeResponding} 
(Y) = volume is currently responding to SNMP 
queries 

${VolumeSize} Size of volume, in bytes 

${VolumeSpaceAvailable} Total space available on volume, in bytes 

${VolumeSpaceUsed} Total space used on volume, in bytes 

${VolumeType} 
Volume type, as reported by hrStorageType OID 
(Removable Disk/Fixed Disk/Compact 
Disc/Virtual Memory/RAM/etc) 

${VolumeTypeIcon} Filename of icon for volume type 

 

Wireless Variables 

The following wireless variables are valid for use in Network Atlas tooltips. 

Variable Description 

${WirelessAP} 
States if node is being polled by the wireless poller (1) or 
not (0) 

${ WirelessLastStatPoll } Date and time node last polled by wireless poller 

${ WirelessPollInterval } 
Interval, in minutes, between wireless polling attempts on 
node 

${ WirelessStatBlockUntil } Date and time node may be polled again by wireless poller 
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